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Obijectives

> After completing this module, you will be able to:

— Describe the high level synthesis flow

— Understand the control and datapath extraction

— Describe scheduling and binding phases of the HLS flow
— List the priorities of directives set by Vivado HLS

— List comprehensive language support in Vivado HLS

— ldentify steps involved in validation and verification flows
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» Introduction to High-Level Synthesis
» High-Level Synthesis with Vivado HLS
» Language Support

» Validation Flow

» Summary
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High-Level Synthesis: HLS

» High-Level Synthesis
— Creates an RTL implementation from C level
— Extracts control and dataflow from the source code
— Implements the design based on defaults and @ @

user applied directives Vivado HLS

» Many implementation are possible from the @
same source description
— Smaller designs, faster designs, optimal designs

— Enables design exploration @

RTL Export

IP-XACT Sys Gen
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Design Exploration with Directives
Toop: for (i=3;>=07-) {
One body of code: cormteldy
Many hardware outcomes Pl

shift_reg[i]-shift_reg[i-1];
acc=shift_regfi]"c(i];

Before we get into details, let’s look
}

The same hardware is used for each iteration of

under the hood ....
Different hardware is used for each iteration of the Different iterations are executed concurrently:
the loop: loop: *Higher area
*Small area «Higher area *Short latency
+Long latency -Short latency +Best throughput
-Low throuahput +Better throuahput

Intro to HLS 11- 5
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Introduction to High-Level Synthesis

» How is hardware extracted from C code?

— Control and datapath can be extracted from C code at the top level

— The same principles used in the example can be applied to sub-functions

« At some point in the top-level control flow, control is passed to a sub-function

» Sub-function may be implemented to execute concurrently with the top-level and or other sub-functions
» How is this control and dataflow turned into a hardware design?

— Vivado HLS maps this to hardware through scheduling and binding processes
> How is my design created?

— How functions, loops, arrays and 1O ports are mapped?

© Copyright 2013 Xilinx

£ XILINX » ALL PROGRAMMABLE.




HLS: Control Extraction

void fir
data_t*y,
coef_tc[4],
data_tx

W meeccssssos====

static data_t shift_reg[4];
acc_tacc;
inti;

acc=0;
loop: for (i=3;i>=0;i--) {
if (i==0) {
acc+=x"c[0];
shift_reg[0]=x;
}else {
shift_reg[i]=shift_regf[i-1];
acc+=shift_regfi]*c[i];

From any C code example ..

Intro to HLS 11-7

Function Start

For-Loop Start

For-Loop End

Function End

Control Behavior

Finite State Machine (FSM)

states

of behavior

The loops in the C code correlated to states

This behavior is extracted into a hardware

state machine
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HLS: Control & Datapath Extraction

Control Behavior

Control & Datapath Behavior

Code Operations
void fir
data_t*y,
coef_tc[4],
data_tx RDx
i —>| RDc

static data_t shift_reg[4];
acc_tacc;
inti; /
acc=0;
loop: for (i=3;i>=0;i--) {
if (i==0) {
acc+=x"c[0];
shift_reg[0]=x;
}else {
shift_reg]i]=shift_reg[i-1];
acc+=shift_reg[il*cfi;

}
*y=acc;

From any C code example ..
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WRy

Finite State Machine (FSM)
states

Control Dataflow

RDx

i
:

Operations are

The control is
known

extracted...

A unified control dataflow behavior is
created.
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High-Level Synthesis: Scheduling & Binding

» Scheduling & Binding
— Scheduling and Binding are at the heart of HLS
» Scheduling determines in which clock cycle an operation will occur
— Takes into account the control, dataflow and user directives
— The allocation of resources can be constrained
» Binding determines which library cell is used for each operation
— Takes into account component delays, user directives

oy & SR i

SchedulingJ L Binding

L (Verilog, VHDL, SystemC) J
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Scheduling

> The operations in the control flow graph are mapped into clock cycles

void foo ( a
fioat b
2=c+tl; c
3=d"2; d H\__'
}out=t3—e; e out
1
[ | RS | S | RS

> The technology and user constraints impact the schedule
— A faster technology (or slower clock) may allow more operations to occur in the same clock cycle
1 | |
DO i e
» The code also impacts the schedule
— Code implications and data dependencies must be obeyed
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Binding

» Binding is where operations are mapped to cores from the hardware library
— Operators map to cores

» Binding Decision: to share
— Given this schedule: I 1 I L
L* e 1 * 1 - |
+ Binding must use 2 multipliers, since both are in the same cycle
« It can decide to use an adder and subtractor or share one addsub

» Binding Decision: or not to share
— Given this schedule: g Sy Y oy TN oy
[ S B
» Binding may decide to share the multipliers (each is used in a different cycle)
« Or it may decide the cost of sharing (muxing) would impact timing and it may decide not to share them
* It may make this same decision in the first example above too

Intro to HLS 11- 11 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.
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Understanding Vivado HLS Synthesis

> HLS
— Vivado HLS determines in which cycle operations should occur (scheduling)
— Determines which hardware units to use for each operation (binding)
— It performs HLS by :
» Obeying built-in defaults
« Obeying user directives & constraints to override defaults
« Calculating delays and area using the specified technology/device
» Understand the priority of directives
1. Meet Performance (clock & throughput)
«  Vivado HLS will allow a local clock path to fail if this is required to meet throughput
«  Often possible the timing can be met after logic synthesis
2. Then minimize latency
3. Then minimize area
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The Key Attributes of C code

Functions: All code is made up of functions which represent the design

void fir hierarchy: the same in hardware
data_t*y,
ggte;_:im Top Level 10 : The arguments of the top-level function determine the

)4 hardware RTL interface ports

static data_t shift_reg[4]; . . .
acc tacc; ol Types: All variables are of a defined type. The type can influence the area

and performance

Loops: Functions typically contain loops. How these are handled can have a
major impact on area and performance

shift_reglil=shift_reg[i-1l; Arrays: Arrays are used often in C code. They can influence the device 10
; =Sl el and become performance bottlenecks

}
*y=acc;

Operators: Operators in the C code may require sharing to control area or
specific hardware implementations to meet performance

Let’s examine the default synthesis behavior of these ...

Intro to HLS 11- 14 © Copyright 2013 Xilinx £ XILINX » ALL PROGRAMMABLE.




Functions & RTL Hierarchy

» Each function is translated into an RTL block

— Verilog module, VHDL entity
Source Code

void A() { ..body A..}

void B() { ..body B..}

void C() {

B();

}

void D()
B();

}

void foo_top() {
A(...);
C(...);

D(...)
) | my_codec |

RTL hierarchy

Each function/block can be shared like any other component (add, sub, etc) provided
it’s not in use at the same time

— By default, each function is implemented using a common instance

— Functions may be inlined to dissolve their hierarchy

« Small functions may be automatically inlined

Intro to HLS 11- 15
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Types = Operator Bit-sizes

Code

void fir
data_t*y,
coef_tc[4],
data_tx

At

static data_t shift_reg[4];

acc_tacc;
inti;
acc=0;

loop: for (i=3:i>=0;i--) {

}

*y=acc;

if (i==0) {
acc+=x"c[0];
shift_reg[0]=x;

Yelse {
shift_reg[i]=shift_regf[i-1];
acc+=shift_regfi]*c[i];

}

i

Operations

ms)

BEEEAERE

D
RD

x

From any C code example ...

Intro to HLS 11- 16
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—

Operations are
extracted...

—

Standard C types

long long (64-bit)

int (32-bit)
float (32-bit)

Arbitary Precision types

ap(u)int types (1-1024)
ap_(u)int types (1-1024)
ap_fixed types

sc_(u)int types (1-1024)
sc_fixed types

C:
C++:

C++/SystemC:

short (16-bit)
char (8-bit)

Types

unsigned types

double (64-bit)

Can be used to define any variable to be a specific bit-width (e.g. 17-bit, 47-

bit etc).

The C types define the size of the hardware used:
handled automatically

© Copyright 2013 Xilinx
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Loops

> By default, loops are rolled
— Each C loop iteration = Implemented in the same state @
— Each C loop iteration = Implemented with same resources \

void foo_top (..) {

Add: for (i=3;i>=@;i--) {
b = a[i] + b;

i | Srinesi 3

Loops require labels if they are to be referenced by Tcl
directives
(GUI will auto-add labels)

— Loops can be unrolled if their indices are statically determinable at elaboration time
» Not when the number of iterations is variable

— Unrolled loops result in more elements to schedule but greater operator mobility
* Let’s look at an example ....

Intro to HLS 11- 17 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.
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Data Dependencies: Good

e (30 L== [ % [>= [l== | * | >= (l== [ * [ >= | == | * [ > || w
if<i==0>([0] | S R | | S | S | | S o [ |
acc+=x*c[0];
hiff_reg(0]—x; (T bz hmccond Imczond
}else {
shift_reg[i]=shift_regf[i-1]; Iteration 1 Iteration 2 Iteration 3 Iteration 4
acc+=shift_regfi]*c[i];

}
Yoo The read X operation has
) JREE good mobility

» Example of good mobility

— The read on data port X can occur anywhere from the start to iteration 4
» The only constraint on RDx is that it occur before the final multiplication

— Vivado HLS has a lot of freedom with this operation
« It waits until the read is required, saving a register
» There are no advantages to reading any earlier (unless you want it registered)
* Input reads can be optionally registered

— The final multiplication is very constrained...
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Data Dependencies: Bad

B L== (L * [ >= [l== || * ([ »= ([ == (L * || »= || == [L* (| >= | v |
if (i==0) { I | IS | AT | S | - | | S | ST [ ... | |
acc+=x"c[0];
shift_reg[0]=x; lil \L] \L‘ \L]

I

}esﬁﬁt‘_reg[i]:shift_reg[i-1]; Iteration 1 Iteration 2 Iteration 3 Iteration 4
acc+=shift_regfi]*c[i];

}

2 . Mult is very

. y=acc; constrained

> Example of bad mobility
— The final multiplication must occur before the read and final addition
* It could occur in the same cycle if timing allows
— Loops are rolled by default
» Each iteration cannot start till the previous iteration completes
+ The final multiplication (in iteration 4) must wait for earlier iterations to complete
— The structure of the code is forcing a particular schedule
* There is little mobility for most operations
— Optimizations allow loops to be unrolled giving greater freedom
Inroto HLS 11- 19 © Copyright 2013 Xilinx £ XILINX » ALL PROGRAMMABLE.

Schedule after Loop Optimization

> With the loop unrolled (completely)
— The dependency on loop iterations is gone
— Operations can now occur in parallel
« If data dependencies allow
« If operator timing allows

— Design finished faster but uses more operators
+ 2 multipliers & 2 Adders

ﬁ

REE HE
REREREEE

void fir
» Schedule Summary N
. . . . . loop: for (i=3ii>=0i-) {
— All the logic associated with the loop counters and index checking are =001 ['0] '
acc+=x"c[0];
now gone shift_reg[0]=x;
. ey
— Two multiplications can occur at the same time shift_regil=shift_regli-1];
acc+=shift_regfi]*c[i];
* All 4 could, but it's limited by the number of input reads (2) on coefficient port C ) }
— Why 2 reads on port C? s

» The default behavior for arrays now limits the schedule...
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Arrays in HLS

> An array in C code is implemented by a memory in the RTL
— By default, arrays are implemented as RAMSs, optionally a FIFO

void foo_top(intx, ...)

’ AIN]
int A[NJ;
Li:for (i =05i<N;i++)

Ali+x] = All] +i;
}

» The array can be targeted to any memory resource in the library

— The ports (Address, CE active high, etc.) and sequential operation (clocks from address to data out)
are defined by the library model

— All RAMs are listed in the Vivado HLS Library Guide
> Arrays can be merged with other arrays and reconfigured

— To implement them in the same memory or one of different widths & sizes
> Arrays can be partitioned into individual elements

— Implemented as smaller RAMs or registers
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Top-Level 10 Ports

» Top-level function arguments

— All top-level function arguments have a default hardware port type
» When the array is an argument of the top-level function

— The array/RAM is “off-chip”

— The type of memory resource determines the top-level 10 ports

— Arrays on the interface can be mapped & partitioned
« E.g. partitioned into separate ports for each element in the array

void foo_top(int A[3*N] , int x)

{
Li:for (i = 0;i<N;i++)
Ali+x] = Ali] + i

Number of ports defined by the
RAM resource

» Default RAM resource
— Dual port RAM if performance can be improved otherwise Single Port RAM
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Schedule after an Array Optimization
> With the existing code & defaults e (| noe | R
. I&I I&I acc+=x*c[0];
— Port C is a dual port RAM | nox| shift_reg[0]=x;
* * }els.e( .. . "
— Allows 2 reads per clock cycles i b S regf-ohit roq- 1
* 10 behavior impacts performance L L+ | }}
Note: It could have performed 2 reads in the original rolled design but a2
there was no advantage since the rolled loop forced a single read per mu
cycle ri_
RDc
RDc
> With the C port partitioned into (4) separate ports | moe |
— All reads and mults can occur in one cycle '—llr?l
— If the timing allows [~
» The additions can also occur in the same cycle ITI
» The write can be performed in the same cycles ij
* Optionally the port reads and writes could be registered I—h‘l I
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Operators

> Operator sizes are defined by the type

— The variable type defines the size of the operator
» Vivado HLS will try to minimize the number of operators

— By default Vivado HLS will seek to minimize area after constraints are satisfied
> User can set specific limits & targets for the resources used

— Allocation can be controlled
« An upper limit can be set on the number of operators or cores allocated for the design: This can be used to force sharing

« e.g limitthe number of multipliers to 1 will force Vivado HLS to share
| | I I I I | | Use 1 mult, but take 4 cycle even if it could be done in

@ @ E] @ 1 cycle using 4 mults
— Resources can be specified

« The cores used to implement each operator can be specified

« e.g. Implement each multiplier using a 2 stage pipelined core (hardware)

I_\_I_\_‘_\_I_\_ Same 4 mult operations could be done with 2 pipelined

( 3 | 1 ] mults (with allocation limiting the mults to 2)
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Comprehensive C Support

> A Complete C Validation & Verification Environment
— Vivado HLS supports complete bit-accurate validation of the C model
— Vivado HLS provides a productive C-RTL co-simulation verification solution
» Vivado HLS supports C, C++ and SystemC
— Functions can be written in any version of C
— Wide support for coding constructs in all three variants of C
» Modeling with bit-accuracy
— Supports arbitrary precision types for all input languages
— Allowing the exact bit-widths to be modeled and synthesized
» Floating point support
— Support for the use of float and double in the code
» Support for OpenCV functions
— Enable migration of OpenCV designs into Xilinx FPGA

— Libraries target real-time full HD video processing
Intro to HLS 11- 26 © Copyright 2013 Xilinx 8 X||_|NX » ALL PROGRAMMABLE.
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C, C++ and SystemC Support

» The vast majority of C, C++ and SystemC is supported
— Provided it is statically defined at compile time
— Ifit's not defined until run time, it won’ be synthesizable

» Any of the three variants of C can be used
— If C is used, Vivado HLS expects the file extensions to be .c
— For C++ and SystemC it expects file extensions .cpp

Intro to HLS 11- 27 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.
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C Validation and RTL Verification

> There are two steps to verifying the design
— Pre-synthesis: C Validation §

+ Validate the algorithm is correct

Constraints/
Directives

— Post-synthesis: RTL Verification S
+ Verify the RTL is correct
» C validation
— A HUGE reason users want to use HLS
+ Fast, free verification
- Validate the algorithm is correct before synthesis
+ Follow the test bench tips given over
> RTL Verification
— Vivado HLS can co-simulate the RTL with the

Verify RTL @

L RTL Export
original test bench IP-XACT Sys Gen PCore
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C Function Test Bench

> The test bench is the level above the function
— The main() functionis above the function to be synthesized
» Good Practices
— The test bench should compare the results with golden data
 Automatically confirms any changes to the C are validated and verifies the RTL is correct
— The test bench should return a 0 if the self-checking is correct

+ Anything but a 0 (zero) will cause RTL verification to issue a FAIL message

+ Function main() should expect an integer return (non-void)

int main () {
int ret=0;

ret = system("diff --brief -w output.dat output.golden.dat");
if (ret 1= 0) {

printf("Test failed !1\n");

ret=1;
}else {

printf("Test passed \n");

return ret;
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Determine or Create the top-level function

> Determine the top-level function for synthesis
> If there are Multiple functions, they must be merged
— There can only be 1 top-level function for synthesis

Given a case where functions func_A and Re-partition the design to create a new single
func_B are to be implemented in FPGA top-level function inside main()

i i #include func_AB.h
int main () { int main (a,b,c,d) {
func_A(a,b,*i1); func_A
func_B(c,1,2); func 8 fune_B(e D)
func_C("i2,ret) func_C func_AB (a,b,c, *it, i2);
returnret; func_C(i2,ret)
} returnret;
}
func_AB.c
#include func_AB.h
func_AB(a,b,c, *i1, *i2) {
Recommendation is to separate test ::::—Qﬁ:;?,{fl,ﬁ);
bench and design files -
}
Intro to HLS 11- 31 © Copyright 2013 Xilinx 8 X|L|NX » ALL PROGRAMMABLE.

» Introduction to High-Level Synthesis
> High-Level Synthesis with Vivado HLS
» Language Support

» Validation Flow

» Summary

Intro to HLS 11- 32 © Copyright 2013 Xilinx 8 X|L|NX » ALL PROGRAMMABLE.




X =7
Summary

> In HLS

— C becomes RTL

— Operations in the code map to hardware resources

— Understand how constructs such as functions, loops and arrays are synthesized
> HLS design involves

— Synthesize the initial design

— Analyze to see what limits the performance

« User directives to change the default behaviors
« Remove bottlenecks

— Analyze to see what limits the area
« The types used define the size of operators
< This can have an impact on what operations can fitin a clock cycle
» Use directives to shape the initial design to meet performance
— Increase parallelism to improve performance
— Refine bit sizes and sharing to reduce area

Intro to HLS 11- 33 © Copyright 2013 Xilinx &£ XILINX » ALL PROGRAMMABLE.
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Objectives

> After completing this module, you will be able to:

— List various OS under which Vivado HLS is supported

— Describe how projects are created and maintained in Vivado HLS

— State various steps involved in using Vivado HLS project creation wizard

— Distinguish between the role of top-level module in testbench and design to be synthesized
— List various verifications which can be done in Vivado HLS

— List Vivado HLS project directory structure

Using Vivado HLS 12 -2 © Copyright 2013 Xilinx &£ XILINX » ALL PROGRAMMABLE.
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Using Vivado HLS 12 -3

> Project Creation using Vivado HLS
> Synthesis to IPXACT Flow

> Other Ways to use Vivado HLS

© Copyright 2013 Xilinx
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| Vivado 2013.3

8 vivado 2013.3 Tcl Shell

¢ Vivado 2013.3

| Accessories

L. SDK

| System Generator

I Vivado HLS
B Vivado HLS 2013.3 Command
[ ] vivado HLS 2013.3

The first step is to open or create a
project

Using Vivado HLS 12 - 4

Invoke Vivado HLS from Windows Menu

[+ vivado HLS.

File Edit Project Solution Window Help
/] Vivado HLS Welcome Page i3

VIVADO %2

Getting Started
/"" ".\ Create New Project

|\ New Project Wizard will guide you through
\Z S\‘ the process of selecting design sources
~— W and a target device for a new project

Vi Open Project
(== Open cne of the most recently used
\ projects, or open any previously created

project

Open Example Project
> Browse example projects.

High-Level Synthesis

Documentation

Tutorials

Invaluable for firsttime users or to try new
features.

User Guide

More detailed info on Vivado HLS
commands, dialogs and buttons

4 B

A

Release Notes Guide

Information about installation and new
features in this release.

TE

© Copyright 2013 Xilinx
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Vivado HLS GUI

¢ Vivado HLS ==}
File Edit Project Solution Window Help

! - RElRoR- 3 KRvB~0O~v|pvu@E A~2|®
1 Debug [+ squs;s
CEminiin, © "~ O = O = Outline i3 i Directive =0
No project is n outline is not available.
open

Select:
File->Open Project...
or

File->New Project.. Information

Pane Aucxiliary Pane

Project
Explorer

Pane [ Gonsoie @@ Errors| & Wamings [ORT Bl f @3> =0
JCOT Build Console [fir_prj]

Console
Pane

Using Vivado HLS 12 -5 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.
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Vivado HLS Projects and Solutions
» Vivado HLS is project based - =
— A project specifies the source code which will be synthesized + & matrixmul prj
— Each project is based on one set of source code ‘;f;?.i’;.ii
— Each project has a user specified name e macon Source
> A project can contain multiple solutions e sestcnm
— Solutions are different implementations of the same code ‘ C' :':g:;fm
— Auto-named solutiont, solution2, etc. & impl
— Supports user specified names : g?;:
~ Solutions can have different clock frequencies, target technologies, synthesis B mon?
directives | Project Level I | Solution Level
» Projects and solutions are stored in a hierarchical directory structure
— Top-level is the project directory
— The disk directory structure is identical to the structure shown in the GUI project
explorer (except for source code location)
Using Vivado HLS 12-7 © Copyright 2013 Xilinx £ XILINX > ALL PROGRAMMABLE.
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Vivado HLS Step 1: Create or Open a project

» Start a new project
— The GUI will start the project wizard to guide you through all the steps

File| Edit Project Solution Window |

[ New File..
Open File... File Edit Project Solution Window Help
Refresh F5
% | o = [

9 New Project 5y ‘ ?
Open Project
Archive Project...

Close Project...

L RecentProject ] Optionally use the Toolbar Button to
Close Ctr+W Open New Project
Close All Ctrl+Shift+W
Save Ctrl+S
Save As...

Save All Ctrl+Shift+S
Exit

» Open an existing project
— All results, reports and directives are automatically saved/remembered
— Use “Recent Project” menu for quick access

Using Vivado HLS 12 -8 © Copyright 2013 Xilinx &£ XILINX » ALL PROGRAMMABLE.




Project Wizard

-File Edit Project Solution Window
[ NewFile..
Open File.

> The Project Wizard guides users through the steps of opening a new project

Refresh ES

Step-by-step guide ... |

% New Project..

| Newe Vivacio HLS Project

| Project Config
Create Vivad HIS

Prjectrame: gt

Location: Coup\is\Iavsabl

Next> Cancel

Define project and
directory

Add design source
files

Specify test bench
files

Project Level
Information

.

Using Vivado HLS 12-9

© Copyright 2013 Xilinx

Specify clock and

e———) =

1st Solution
Information

select part

Define Project & Directory

> Define the project name

— Note, here the project is given the
extension .prj

— A useful way of seeing it’s a project (and
not just another directory) when browsing
> Browse to the location of the project

— In this example, project directory “dct.prj” will
be created inside directory “lab1”

Using Vivado HLS 12 - 10

© Copyright 2013 Xilinx

[+ | New Vivado HLS Project

£ XILINX » ALL PROGRAMMABLE.

Project Configuration

Create Vivado HLS project of selected type

y

Project name: dct.prj|

Location: C\xup\hls\labs\labl

< Back Next >

Finish Cancel

Browse...

£ XILINX » ALL PROGRAMMABLE.




Add Design Source Files

> Add Design Source Files

[+ New Vivado HLS Project ==

— This allows Vivado HLS to determine the top-level design for Add/Remove Files o

synthesis, from the test bench & associated files T T ——— 'EV
— Not required for SystemC designs

> Add Files... i
Design Files

— Select the source code file(s) Name CrLAGS
— The CTRL and SHIFT keys can be used to add multiple files ot NewfFile.. |
— No need to include headers (.h) if they reside in the same Edit CFLAGS

directory Remove

> Select File and Edit CFLAGS...

— If required, specify C compile arguments using the “Edit

CFLAGS...” There is no need to add the location of standard

Vivado HLS or SystemC header files or header
files located in the same project location

— Define macros:-DVERSION1

— Location of any (header) files not in the same directory as the

source: -I../include [ <Back | New> || Finisn Cancel
Using Vivado HLS 12- 11 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.

Specify Test Bench Files

> Use “Add Files” to include the test bench (17 ] New vivado s Projct =
— Vivado HLS will re-use these to verify the RTL using co- | Add/Remove Files +E§/
SimUIatiOn Add/remove C-based testbench files (design test)
> And all files referenced by the test bench TestBench Files
— The RTL simulation will be executed in a different directory Name CFLAGS Add Files...
(Ensures the original results are not over-written) :’:;;‘f““ New File...
— Vivado HLS needs to also copy any files accessed by the outgoldendat Add Folder...
test bench Edit CFLAGS...
— Input data and output results (*.dat) are shown in this Remove
example
> Add Folders
— If the test bench uses relative paths like
“sub_directory/my_file.dat” you can add “sub_directory” as
a folder/directory
> Use “Edit CFLAGS...” T re— | L [
— Toadd any C compile flags required for compilation \

Using Vivado HLS 12 - 12 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.




e =7
Test benches |

» The test bench should be in a separate file
» Or excluded from synthesis

— The Macro __SYNTHESIS__ can be used to isolate code which will not be synthesized
« This macro is defined when Vivado HLS parses any code (-D__SYNTHESIS )

I/ test.c
#include <stdio.h>
void test (int d[10]) {
int acc = 0;
int i;
for (i=05i<105i++) { Design to be synthesized
acc += d[i]; —
d[i] = acc;
}

#ifndef __SYNTHESIS__
int main () {

int d[10], i

for _(i=0;i_<1 Osi++) {

)dm =" Test Bench

test(d); - Nothing in this ifndef will be read

for (i=0;i<10;i++) by Vivado HLS

intf(*%d %d\n", i, dil); B

o { e (will be read by gcc)

return 0;
}
#endif

Using Vivado HLS 12- 13
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e =7
Test benches Il

» ldeal test bench
— Should be self checking

» RTL verification will re-use the C test bench
— If the test bench is self-checking

+ Allows RTL Verification to be run without a requirement to check the results again
— RTL verification “passes” if the test bench return value is 0 (zero)
« Actively return a 0 if the simulation passes
int main () {
/I Compare results

The —w option ensures the
“newline” does not cause a
difference between Windows and
Linux files

printf("Test passed \n", ret); return 0;

int ret = system("diff --brief -w test_data/output.dat test _data/output.golden.dat");
if (ret 1= 0) {

printf("Test failed !!\n", ret); return 1;
}else {

— Non-synthesizable constructs may be added to a synthesize functionif __ SYNTHESIS__ is used
#ifndef __SYNTHESIS__

image_t *yuv = (image_t *)malloc(sizeof(image_t));

#else // Workaround malloc() calls w/o changing rest of code
image_t _yuv;

#endif

Using Vivado HLS 12- 14
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Solution Configuration
> Provide a solution name iltow oo s o = -
— Default is solution1, then solution2 etc. Solution Configuration M
Create AutoESL solution for selected technology Y
> Specify the clock
— The clock uncertainty is subtracted from the clock e
to provide an “effective clock period” JiliEedcad 10 Eri= T
i “ . . » : Part Selection
- \S/;,riﬂcégsl_s uses the “effective clock period” for Par: XCTZ020CKHBA-A
— Provides users defined margin for downstream
RTL synthesis, P&R
> Select the part !
— Select a device family after applying filters such
as family, package and speed grade (see next !
S||de) < Back Finish | ‘ Cancel
Using Vivado HLS 12 - 15 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.

Selecting Part and Implementation Engine

> Select the target part either through

" Device Sclection Disiog sm
Parts or Boards specify
RTL Tool Specify Filter
Ao - Product Category: [Any ~|Package:  [cigasa -
» Select RTL Tools RTL Tool b |10 ue T
_ AUtO Auto - Sub-Family: zynq ~ | Temp Grade: | Any -
Auto
+ Will select Vivado for 7 Series Sans
. ISE Device Family Package Speed
and Zynq devices = = 2
H f ~ H HH x72020cga84-2 zyng clgdsa -2
+ Will select ISE for Virtex-6 and earlier families T s s N |
— Vivado " Device Selection Dislog [—x
- |SE RTL Tool Specify Filter

uto  ~ Parts Famil - =
+ ISE Design Suite must be installed and must be included : m.:;: =
in the PATH variable

Speed Grade: Any ke

Search: v

Board Part Family Package  Speed

2ynq ZC702 Evaluation Platform xc72020cIg484-1 zynq clgdgd -1

2ynq ZC706 Evaluation Platform xc720451fg900-1 zynq 9900 -1

ZedBoard Zyng Evaluation and Developmen..| xc7z020¢lg484-1 Zyng clgddd -1 i

Using Vivado HLS 12 - 16
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Clock Specification

» Clock frequency must be specified
— Only 1 clock can be specified for C/C++ functions
— SystemC can define multiple clocks
> Clock uncertainty can be specified
— Subtracted from the clock period to give an effective clock period
— The effective clock period is used for synthesis
+ Should not be used as a design parameter |W|
] L

» Do not vary for different results: this is
your safety margin
Effective Clock Period
used by Vivado HLS

— A user controllable margin to account
Clock Uncertainty I

for downstream RTL synthesis and P&R

[
=

Margin for Logic Synthesis and
P&R

Using Vivado HLS 12 - 17 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.

A Vivado HLS Project

# | Vivado HLS - detprj (C:\xup\his\labs\lab1\dct.prj) =8
File Edit Project Solution Window Help
1 GxX|E8 SRR TR F=ll =R )
35 Debug [/ Synthesis |+ Analysis
& Explorer 22 $ < O|(hdetaes = O)[Bz Outline &2 . ¥ Directive il
& detprj 1 - PR o %
) Includes Zinclude:"dce.h™ Information Pane 8 deh
£ Source Tvold dok Hdtdct. data t s|RCAD view and editany file from the ° det ld(det data 1), det data A1) - voi
4 dete 5 Project Explorer o dct_coeff_table.txt |
ks Test Bench 6 unsigned int k, n; o dct_2d(dct_data_t[)[), dct_data_t(]{]) : void
= solution1 7 int tmp; ® read_data(short{], short{][}) : void
# constraints 8  const dct_data_t det_coeff_table[DCT_SIZE][DCT_SIZE] = { o write_data(short{][], short{]) : void
& det(short(], short(]) : void

¥ directives.tcl

O#include "dct_coeff_table.txt™

9 scripttel :” i
12DCT_Outer_Loop:
13 for (k = 8; k < DCT_SIZE; ke+) {
14DCT_Inner_Loop: —
- 15 for(n = @, tmp = @; n < DCT_SIZE; n++) { Auxiliary Pane
. Pro_ect E_x lorer . 16 int coeff = (int)dct_coeff_table[k][n]; Cross-referenced with the Information Pane
Project files displayed in a 17 tmp += src[n] * coeff; (here it shows objects in the source code)
hierarchal view 18 3
19 dst[k] = DESCALE(tmp, CONST_BITS); =
« I v
B Console . @] Errors| & Wamings & 4 pEl = O
CDT Build Console [detprj]

Console Pane
Displays Vivado HLS run time messages

Writable Smart Insert il

Using Vivado HLS 12 - 18 © Copyright 2013 Xilinx &£ XILINX » ALL PROGRAMMABLE.




Vivado HLS GUI Toolbar

» The primary commands have toolbar buttons
— Easy access for standard tasks
— Button highlights when the option is available
» E.g. cannot perform C/RTL simulation before synthesis

T i

| Create a new Project |(—|

I Change Project Settings

| Open Analysis Viewer I

Compare Reports |

| Create a new Solution Open Reports I

'I Export RTL |

I Change Solution Settings |<—

,I Run C/RTL Cosimulation I

- - 1
| Run C Simulation fe A Run C Synthesis |
Using Vivado HLS 12 - 19 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.

X =7
Files: Views, Edits & Information

+*| Vivado HLS - det prj (C?wup\his\abs\labT\dct.pri) i | ) e
File Edit Project Solution Window Help
@ X|EE E S@s%a8d e -da @@
% Debug [] Synthesis | & Analysis
s Explorer & $ ~ 0|([Gderetd ~ O3 Outline 2 . 1 Directive -a
& detprj 1 - PR o %7
9 Includes 2#include "dct.h” o deth
¢ Source 2 det_1d(det_data_tf), det_data_t())

4void det_ld(dct_data_t src[DCT_SIZE), dct_data_t dst[DCT_SIZE])|

(8 dete
ik Test Bench

°
o det coeff table.txt

© ddt_2d(dct_data_t)[], det_data_H)[})  void
.

.

.

unsigned int k, n;

7 int tmp; read_data(short(], short[][]) : void
8  const dct_data_t det_coeff_table[DCT_SIZE][DCT_SIZE] = { ‘write_data(short[] [, shortl]} : ve
o directivestcl 9#include "dct_coeff_table.txt” det(short[l, shortl]}
& scripticl ;“\ b
" PR " T 12DCT_Quter_Loop:
Open file and it will display in 13 for (k = 0; k < DCT_SIZE; ke+) {
i i 14DCT_Inner_Loop:
the information [FEID 15 for(n = @, tmp = @; n < DCT_SIZE; n++) {
16 int coeff = (int)dct_coeff_table[k][n];
17 tap += src[n] * coeff;
18 } — - — -
19 dst[k] = DESCALE(tmp, CONST_{ The Auxiliary pane is context sensitive with respect to the
L= b information pane
B Console & @) Errors| & Warnings

GOTIB A ConsaleTdctpinl Here it displays elements in the code which can have directives

specified on them

Writable Smart Insert 1:1
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Outline

» Invoking Vivado HLS

> Project Creation using Vivado HLS
> Synthesis to IPXACT Flow

» Design Analysis

> Other Ways to use Vivado HLS

» Summary

Using Vivado HLS 12- 21 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.

X =7
Synthesis

. | Vivado HLS - detprj (CAxup\his\labs\lab\dct.prj) B E
) Run c SyntheSIs File Edit Project Solution Window Help
P+ B % x| EE B Egte asprasld-Fle@
» Console 35 Debug (LTS s
] ) ) ) Cexplerer 2, o = O dete [ dot_esynthrpt ] = O)[E Outfine & 54 Directive] D
—  Willshow run time information = Synthesis Report for ‘dct’ @7
—  Examine for failed constraints = P 1 i
&= Test Bench Date: Mon Oct 14 15:02:47 2013 B Latency (clock cycles)
" 'T] . . & ol fersion: .3 (build date: Sun Oct 43 & Utilization Estimates
» A “syn” directory is created sl [l v e [ el
.  directives.tel Solution: solutionl T Detail
—  Verilog, VHDL & SystemC RTL i scriptict Froes il S e £l Inertace
g, . y g A, ;" * Tar:el‘devi:e‘r 27:0?::;:84 1 ) Summary
—  Synthesis reports for all non-inlined s | | s
functions - “:::E’g = Timing (ns)
ki S Summary
> Report opens automatically oo, Tpmec | et - ocuqg
— When synthesis completes 2 teney cock cyces s
> Report is outlined in the R e e s Rl T
Auxiliary pane -

1item selected

Using Vivado HLS 12 - 22 © Copyright 2013 Xilinx &£ XILINX » ALL PROGRAMMABLE.




Vivado HLS : RTL Verification

Test
Bench

\/

—

C,C++,
SystemC

Constraints/
Directives

I

s,
e

U

RTL Simulation

-
\/

RTL Export

IP-XACT PCore

Sys Gen

SystemC

RTL output in Verilog, VHDL and

bench

Automatic re-use of the C-level test

within Vivado HLS

RTL verification can be executed from

in automated flow

Support for Xilinx simulators (XSim
and ISim) and 3'¢ party HDL simulators

Using Vivado HLS 12 - 23

© Copyright 2013 Xilinx

£ XILINX » ALL PROGRAMMABLE.

RTL Verification: Under-the-Hood

> RTL Co-Simulation
— Vivado HLS provides RTL verification
— Creates the wrappers and adapters to re-use the C test bench

dut.c(pp)

» Prior to synthesis

« Test bench

» Top-level C function

Using Vivado HLS 12 - 24

_Snihesis 3

DUT wrapper

+ After synthesis

.
.
.

.

© Copyright 2013 Xilinx

Testbench
SystemC wrapper created by Vivado HLS
SystemC adapters created by Vivado HLS
RTL output from Vivado HLS

«  SystemC, Verilog or VHDL

There is no HDL test bench created

£ XILINX » ALL PROGRAMMABLE.




RTL Verification Support

» Vivado HLS RTL Output

— Vivado HLS outputs RTL in SystemC, Verilog and VHDL
» The SystemC output is at the RT Level
 The input is not transformed to SystemC at the ESL
> RTL Verification with SystemC

— The SystemC RTL output can be used to verify the design without the need for a HDL simulator and

license
» HDL Simulation Support
— Vivado HLS supports HDL simulators on both
. . XSim (Vivado Simulator) Supported Supported
Windows & Linux ISim (ISE Simulator) Supported Supported
— The 3rd party simulator executable must be in Mentor Graphics ModelSim  Supported Supported
Synopsys VCS Supported Not Available
OS search path NCSim Supported  Not Available
Riviera Supported Supported

Using Vivado HLS 12-25

© Copyright 2013 Xilinx

£ XILINX » ALL PROGRAMMABLE.

C/RTL Co-simulation

tto% Bl -RAs|ldrie|®
) Start SimU|ati0n i' ]Co—slmulatlon Dialog
. 3 [
- OpenS the d'alog bOX C/RTL Co-simulation

» Select the RTL
—  SystemC does not require a 3" party license

Verilog/VHDL Simulator Selection

— Verilog and VHDL require the appropriate simulator RIL Selection
+ Select the desired simulator [efSptem e S
- Runanyorall . T
» Options 7] Dump Trace

["] Optimizing Compile

—  Can output trace file (VCD format)

—  Optimize the C compilation & specify test bench linker flags
— The “setup only” option will not execute the simulation

» OK will run the simulator
—  Output files will be created in a “sim” directory

Using Vivado HLS 12 - 26 © Copyright 2013 Xilinx

The SystemC simulation can always
I be run: no simulator license required!

[] Do not show this dialog box again.

[ OK J l Cancel l

£ XILINX » ALL PROGRAMMABLE.




Simulation Results

» Simulation output is shown in the console s wm cronmwmmem =)
File Edit Project Solution Window Help
t x & R S8B% 8o v @l e | D
> Expect the same test bench response R . 7 |
— Ifthe C test bench plots, it will with the RTL I8 =0 (et ©steomnne OB Outien 0]~
design (bUt S|OW6I’) yeia Result froviena e
. . 8 detc| Latency Interval
»Sim D|rectory i RIL  Statos min  avg max min | awg  max
8 e VHDL NA NA NA NA NA NA NA
. . . eril NA NA NA NA NA NA NA
— Will contain a sub-directory for each RTL Yo || e e o s 393 0 o0 | i
Wthh |S Vel’lfled ‘»*i:mwap Export the report{htmI) using the Export Wizard
& repor
> Report izﬂemc
— Areport is created and opened automatically s [metcome
b .sj-"lepuﬂ Info: fOSCI/SystemC: Simulation stopped by user.
& systemc er [EET'EEE],EEBCEEW C post checking ...
il Reselte e rguad
@I [SIM-1808] *** C/RTL co-simulation finished: PASS *** -
@I [LIC-101] Checked in feature [VIVADO_HLS] 5
1item selected
Using Vivado HLS 12 - 27 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.
Vivado HLS : RTL Export
‘ RTL output in Verilog, VHDL and SystemC ‘
Sl <——) N—
C, C++, Constraints/
@ @ ‘ Scripts created for RTL synthesis tools |

- r— -
e, —
< 4 g I

RTL Export

| RTL Export to IP-XACT, SysGen, and Pcore formats |

IP-XACT and SysGen => Vivado HLS for 7 Series
and Zynq families

e PCore => Only Vivado HLS Standalone for all

families

RTL Simulation

Using Vivado HLS 12 - 28 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.
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RTL Export Support

> RTL Export
— Can be exported to one of the three types
 IP-XACT formatted IP for use with Vivado System Edition (SE)
= 7 Series and Zynq families only
A System Generator IP block
= 7 Series and Zyng families only
 Pcore formated IP block for use with EDK
= 7 Series, Zynq, Spartan-3, Spartan-6, Virtex-4/5/6 families
> Generation in both Verilog and VHDL for non-bus or non-interface based designs
» Logic synthesis will automatically be performed
— HLS license will use Vivado RTL Synthesis

Using Vivado HLS 12 - 29 © Copyright 2013 Xilinx &£ XILINX » ALL PROGRAMMABLE.

e ==
RTL Export: Synthesis

> RTL Synthesis can be performed to evaluate the RTL
— IP-XACT and System Generator formats: Vivado synthesis performed ——
— Pcore format: ISE synthesis is performed ottent

l_|_|

1
r T T T 1

\ J
1 1

RTL Synthesis Results IP Repositories
> RTL synthesis results are not included with the IP package

— Evaluate step is provided to give confidence
» Timing will be as estimate (or better)
+ Area will be as estimated (or better)
— Final RTL IP is synthesized with the rest of the RTL design
» RTL Synthesis results from the Vivado HLS evaluation are not used

_-
-
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RTL Export: IP Repositories

> IP can be imported

Project Directory
Top-level project directory
(there must be one)

into other Xilinx tools

In Vivado :

1. Project Manager > IP Catalog
2. Add IP to import this block

3. Browse to the zip file inside “ip”

Solution directories

There can be multiple solutions for each project. Each
solution is a differentimplementation of the same

(project) source code

I
=

‘—ﬂ-ﬂ

L

In System Generator :
1. Use XilinxBlockAdd

2. Select Vivado_HLS block type
3. Browse to the solution directory 1.

e

In EDK :
Copy the contents of the “pcore” direcory

Using Vivado HLS 12 - 31

2. Paste into the EDK project pcore direcotry
3. Project > Rescan Local Repository

© Copyright 2013 Xilinx

£ XILINX » ALL PROGRAMMABLE.

RTL Export for Implementation

» Click on Export RTL
— Export RTL Dialog opens

» Select the desired output format

System Generator for DSP
System Generator for DSP (ISE)
Pcore for EDK

Synthesized Checkpoint (.dcp)

» Optionally, configure the output
> Select the desired language

» Optionally, click on Evaluate button
for invoking implementation tools

from within Vivado HLS

FiC@b% aar-vE a9y F @
|+ | Export RTL Dialog ﬂ
Export RTL a + | IP Identification Dialog " @M
E
Configuration
Format Selection
[P Catalog ~J[c .. m— Vendor xilinxcom
Options Library: his
Version: 1.0
[[JEvaluate |VHDL -
Description:  An IP generated by Vivado HLS
Display Name: my dct ip|
Taxonomy:

[] Do not show this dialog box again.

» Click OK to start the implementation

Using Vivado HLS 12-32
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X =7
RTL Export (Evaluate Option) Results

' det_cosim.rpt [ det_export.rpt 2 =g

~
> Impl directory created Export Report for ‘dct’ -
— Will contain a sub-directory for each RTL which General Information
is synthesized Report date: Mon Oct 14 15:49:18 -0700 2013
Device target: xc7z020clg484-1
> Report Implementation tool: Xilinx Vivado v.2013.3
— Areport is created and opened automatically Resource Usage
[Vivado HLS Console VHDL
Phase 9 Post Router Timing | Checksum: 17cfbf6fb SLICE 89
Time (s): cpu = ©0:01:00 ; elapsed = ©0:00:28 . Memory (MB): peak = 941.410 ; gain = 93.391 LuT 279 3
INFO: [Route 35-16] Router Completed Successfully = 134
Ending Route Task | Checksum: 17cfbf6fb
DSP 1
Ti : = 80:00:00 ; elapsed = 08:00:28 . M MB): peak = 941.410 ; gain = 93.391
ime (s): cpu elapse emory (MB): peal gain BRAM 5
Routing Is Done. [Vivado HLS Console SRL 0
279 . -
134 Final Timing
1
5 VHDL
Final tining - CPrequired 10000
CP required: 10.000 CP achieved 6,192 —
CP achieved:  6.192
Timing met Timing met
INFO: [Common 17-206] Exiting Vivado at Mon Oct 14 15:49:19 2013...
@I [LIC-101] Checked in feature [VIVADO_HLS] -
Using Vivado HLS 12 - 33 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.

=
RTL Export Results (Evaluate Option Unchecked)

> Impl directory created

— Will contain a sub-directory for both VHDL and Verilog
along with the ip directory

¢= solution1 Vivado HLS Console
. Starting export RTL ...
> No report will be created % constraints 2 3 Lirx avado, LS /3913, 3/bin/vivado_hi. bat C:/xup/hls/Iabs/Lobi/dct .pr/solutionl/expor
@I [LIC-101] Checked out feature [VIVADO_HLS]
! directi @I [HLS-10] Running 'C:/Xilinx/Vivado HL5/2013.3/bin/unwrapped/win6d.o/vivado_hls.exe"

> Observe the console W directivestcl For e Sperinalp on nast. xSpar inalghd: (Wndore NT sedSd version 5.3) on 1

W scripticl in directory 'C:/xup/hls/labs/1ab1’
_ . . . @I [HLS-10] Opening project 'C:/xup/hls/labs/labl/dct.prj’.
No paCklng, I'OUtIng phaSGS . @T [HLS-10] Opening solution 'C:/xup/hls/labs/labl/dct.pri/solutionl’.
& impl @T [SYN-201] Setting up clock ‘default’ with a period of 1@ns.
_ @I [HLS-10] Setting target device to 'xc7z020clg84-1'

= ip @I [IMPL-8] Exporting RTL as an IP in IP-XACT.
= report wroone Vivado v2013.3 (64-bit)

#%k% Sl Build 328145 on Sun Oct 13 18:

154 MDT 2013

& verilog % Ip Build 191624 on Sun Oct 13 14:3:12 MDT 2013
** Copyright 1986-1999, 2001-2013 Xilinx, Inc. All Rights Reserved.
= vhdl - [Common 17-78] Attempting to get a license: Implementation
. [Common 17-81] Feature available: Implementation
& sim INFO: [Device 21-36] Loading parts and site information from c:/Xilinx/Vivado/2013.3/data/|
Parsing RTL primitives file [c:/Xilinx/Vivado/2013.3/data/parts/xilinx/rtl/prims/rtl_prims
= syn Finished parsing RTL primitives file [c:/Xilinx/Vivado/2013.3/data/parts/xilinx/rtl/prins/i

source run_ippack.tcl -notrace
INFO: [Common 17-206] Exiting Vivado at Mon Oct 14 16:15:15 2013...
@I [LIC-101] Checked in feature [VIVADO_HLS]
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Outline

» Invoking Vivado HLS

» Project Creation using Vivado HLS
> Synthesis to IPXACT Flow

» Design Analysis

> Other Ways to use Vivado HLS

» Summary

Using Vivado HLS 12-35 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.

Analysis Perspective

> Perspective for design analysis
— Allows interactive analysis

+ |Vivado HLS - dct_prj (C\Vivado_HLS Tutoria\Design_An:
File Edit Project Soution Window Help
X iR d-PBle@

-
+ |Vivado HLS - cet_prj (CAVivado_HLS TutoraN\Design Analysis\labI\dct_pr) , [ESRECH >
File| Edit Project Solution Window Help |
X Bid-FRlel® 1
O & Schedule Viewer - det =)

RAM DSP FF LUT Latency Intenval Pipeiine type Current Module : dot

o dct 6 1 18233 3959 390 none

Module Hierarchy ¥R IE- iy s LT T

op_Ror
dct_za (Function)

Hierarchical Summary

and Navigation

Performance View
Scheduled operations.
(Ereomanceronie ¥ (Chesouceprotie’) =0 Loops : shown in Yellow are

Pipelined Latency Iniiation Interval _teration Late.
o dat - 3059 3960
 RD_Loop Row  no - 18

Trip count expandable and collapsible
s
©RDloopColno 16 - 2 s
s
s

8 100p_Col no - 2 open the view on sub-blocks
Performance Profile
Latency and Interval
summary for this block | "
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e ===
Performance Analysis

= 0|2 Source 2., =}

ile: C:\Vivado_HLS_Tutorial\Design_Analysis\labl\dct.cp

& Performance - det_1d 2

erarchical Na

Current Module : det > det 2d > det 14

1| -

rk_)peration\control sje0 J[ex ][ e J[ <3 ][ ca ][ =5 2#include "dct h" (W
1 21 _read(wire_rj j 1|

T 2 read(wire re :zmd det_1d(dct_data_t src[DCT_SIZE], dct_di =

[-]1DCT_Outex_ Loo; 6 unsigned intk, n;
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Resources Analysis

Resource View
Scheduled operations
associated with resource:
anything on the same row
shares the same resource

B 1d 73
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0 0
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act_coeff_tab) read 7 inttmp;
[C__dct_costf_tap] read 8 const dot_data_t dct_coeff_table[DCT_SIZEJ[DCT_¢
dct_coeff_tab) read 9#include "dct_coeff_table. txt"
dct _coeff tab) read :? ¥
dct_coeff cab) read 12DCT_Outer_Loop
dct_coeff_tab] = 13 for (k = 0; k < DCT_SIZE; k++) {
[C__dct_coeff _tap] read 14DCT_lnner_Looy
dct_coeff tab) read 15 for(n = 0, tmp = 0; n < DCT_SIZE; n++) {
e f = (int)d ble{k]{n]
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Command Line Interface: Batch Mode

» Vivado HLS can also be run in batch mode
— Opening the Command Line Interface (CLI) will give a shell
Vivado 2013.2 [ & Vivado HLS 2013.3 Command Prompt e

Bl Vivado 2013.3 Tcl Shell
# Vivado 2013.3

Accessories
System Generator
Vivado HLS

| B Vivado HLS 20133 Commamd— Microsoft Windows [ on 6.1.7601]

[#]Vivado HLS 20133 Copyright (c¢) 2009 Microsoft Corporation. All rights reserved

C:\Xilinx\Uivado_HLS$\2013.3>

— Supports the commands required to run Vivado HLS & pre-synthesis verification (gcc, g++, apcc, make)
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Using Vivado HLS CLI

> Invoke Vivado HLS in interactive mode

— Type Tcl commands one at a time

> vivado_hls —i

> Execute Vivado HLS using a Tcl batch file

— Allows multiple runs to be scripted and automated

> vivado_hls —f run_aesl.tcl

> Open an existing project in the GUI

— For analysis, further work or to modify it

> vivado_hls —p my.prj
> Use the shell to launch Vivado HLS GUI
> vivado_hls
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Using Tcl Commands

» When the project is created
— All Tcl command to run the project are created in script.tcl
+ User specified directives are placed in directives.tcl
— Use this as a template from creating Tcl scripts
» Uncomment the commands before running the Tcl script

& detprj 1
5 Includes 2 ## This file is generated automatically by Vivado HLS.
= source 3 ## Please DO NOT edit it.
4 ## Copyright (C) 2013 Xilinx Inc. All rights reserved.
[@ detc 5
@ Test Bench & open_project dct.prj
= solutiont 7 set top det
# constraints 8 add_files ../../ise_labs/labs/lab3/dct.c
& directivestel 9 add_files -tb ../../ise_labs/labs/lab3/dct_test.c
4 scripticl | 3 add_files -tb ../../ise_labs/labs/lab3/in.dat
N 11 add_files -tb ../../ise_labs/labs/lab3/out.golden.dat
& impl b Ml 158
12 open_solution "solutionl
&ip 13 set_part {xc7z020clg484-1}
& report 14 create_clock -period 10 -name default
& verilog 15 source "./dct.prj/solutionl/directives.tcl"
= vhdl 16 csim_design
= verilog 17 esynth_design
& vhdl 18 cosim_design -trace_level none
o am 19 export_design -format ip_catalog -description "An IP generated by Vivado HLS" -vendor ">
& syn »
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Help

> Help is always available
— The Help Menu
— Opens User Guide, Reference Guide and Man Pages

El Console €] Errors | & Warnings & Man Page & =5
|Cmmmands‘ |Desrript|mn‘
open_project ||| SYNTAX -

open_solution set_clock_uncertainty [OPTIONS] <uncertainty> <clock_list> \E
set_directive_allocation

ve_array_map

ective_array_partition The set_clock_uncertainty command sets a margin on the clack period defined
set_directive_array reshape the clock period to create an effective clock period. If the clock uncertainty is not ~
set_directive_clock - < [ ] »

> In interactive mode
— The help command lists the man page for all commands

=/ | DESCRIPTION
=l

Vivado_his> help add files Auto-Complete all commands using the tab

SYNOPSIS key

add_files [OPTIONS] <src_files>
Etc...
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Summary

» Vivado HLS can be run under Windows XP, Windows 7, Red Hat Linux, and SUSE OS
> Vivado HLS can be invoked through GUl and command line in Windows OS, and
command line in Linux

> Vivado HLS project creation wizard involves

— Defining project name and location

— Adding design files

— Specifying testbench files

— Selecting clock and technology

> The top-level module in testbench is main() whereas top-level module in the design is
the function to be synthesized
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Summary

» Vivado HLS project directory consists of

— *.prj project file

— Multiple solutions directories

— Each solution directory may contain
« impl, synth, and sim directories
» The impl directory consists of pcores, verilog, and vhdl folders
 The synth directory consists of reports, systemC, vhdl, and verilog folders
» The sim directory consists of testbench and simulation files
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Lab1 Intro
Vivado HLS Design Flow

Vivado HLS 2013.3 Version
ZedBoard

This material exempt per Department of Commerce license exception TSU © Copyright 2013 Xilinx
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Obijectives

> After completing this lab, you will be able to:

— Create a project in Vivado HLS

— Run C-simulation

— Use debugger

— Synthesize and implement the design using the default options

— Use design analysis perspective to see what is going on under the hood
— Understand and analyze the generated output
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The Design

> This lab uses a simple matrix multiplication example to walk you through the Vivado
HLS project creation and analysis steps. The design consists of three nested loops.
The Product loop is the inner most loop performing the actual elements product. The
Col loop is the outer-loop which feeds next column element data with the passed row
element data to the Product loop. Finally, Row is the outer-most loop. The res]i][jl=0
(line 79) resets the result every time a new row element is passed and new column
element is used 67 #include "matrisamll.h”

S woid matrixmull(

mat_a_t a[MAT_A_ROWS][MAT_A_COLS],
mat_b_t b[MAT_B_ROWS][MAT_B_COLS],
result_t res[MAT_A_ROWS][MAT_B_COLS])

// TIterate over the rows of the A matrix
Row: for(int i = @; i < MAT_A ROWS; i++) {
// Iterate over the columns of the B matrix
Col: for(int j = @; j < MAT_B_COLS; j++) {
// Do the inner product of a row of A and ¢col of B
res[i][j] = @;
Product: for(int k = ©; k < MAT_B_ROWS; k++) {
res[i]1[3] += alillk]l * blk1[3l1;
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Procedure

> Create a project after starting Vivado HLS in GUI mode
> Run C simulation
— to understand the design behavior
> Run the debugger
— to see how the top-level module works
» Synthesize the design
> Analyze the generated output using the Analysis perspective
> Run C/RTL cosimulation
— to perform RTL simulation
» View simulation results in Vivado
— to understand the 1O protocol
> Export RTL in the Evaluate mode and run the implementation
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Summary

> In this lab, you completed the major steps of the high-level synthesis design flow using
Vivado HLS. You created a project, added source files, synthesized the design,
simulated the design, and implemented the design. You also learned that how to use the
Analysis perspective to understand the scheduling
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